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EXECUTIVE SUMMARY 

 



 
The purpose of this document is to summarize the milestones we have achieved in the first part 
of the two quarter long course ENGR 241.The initial aim of our project is to develop a process 
flow for rapid prototyping of waveguides with acceptable losses using a direct write lithography 
tool and to build software for analysing roughness parameters of the waveguides we fabricate.  
 
So far, no comprehensive study for fundamental limitations of the Heidelberg MLA150 for the 
SNF in terms of resolution and actual write pattern has been done. When people begin working 
on the MLA150 they might have a number of questions. What sort of minimum trenches or 
ridges can I achieve with this tool? When I designed curved or angled lines how are these 
actually exposed on the wafer? What is the variability of these small features over long 
distances? What is sort of roughness occurs upon exposure? Our project hopes to answer the 
above questions.  
 
The motivation for this project comes from the disadvantages with current photolithographic 
techniques in the SNF in the production of waveguides. Currently, large optical networks are 
only possible at the SNF with masked lithography, which has a number of disadvantages 
involving cost, turnaround time, and limitations in design flexibility once a mask has been 
ordered. Furthermore, alternative systems are always important in an active nanofabrication 
facility: at the time of the creation of this report, the ASML, the best waveguide photolithography 
tool in the SNF, has been down for more than a week.  
 
The Heidelberg as an alternative option for waveguide creation boasts a number of clear 
advantages: maskless has no cost and no turnaround time. By characterizing and optimizing the 
Heidelberg for waveguides, we hope to demonstrate by the end of two quarters a waveguide 
network with e-beam defined ridge couplers that has acceptable loss (<5db/cm). This would be 
of great benefit to the photonics community within the SNF, who could prototype and test 
semi-lossy photonic structures with the Heidelberg before ordering and producing high quality 
waveguides and photonic structures with masked photolithography.  
 
This quarter we produced an SOP for finding the best dose defocus pair for an arbitrary material 
stack. We also created an SOP for characterizing the line profile of angled ridges and 
generating the line edge roughness RMS and line width roughness RMS. We applied these 
SOP to optimize dose/defocus and find the line width and line edge roughness for Shipley 1um 
3612 photoresist on a plain silicon wafer (L-prime). This will be expanded upon next quarter. 
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1.Quick start guide for creating a mask using L-Edit: (​​design to patterning​​) 
 
We have included a quickstart guide to new users who want to design simple patterns with 
L-Edit computer on the SNF Shared Desktop and use on the Heidelberg. This knowledge is 
normally passed within groups, but as far as this author aware, no start-to-finish design guide 
exists for the SNF community. 
 

A) Getting Started: 
On Desktop open L-edit and open the starter file start.tdb found on the Desktop. You will be 
editing on the Layer named “DESIGN_HERE.” Ignore/Don’t touch Grid Layer, Drag Box Layer, 
Origin Layer, Icon Layer, Error Layer, and Cell Outline Layer. These are used internally. 
 
      B) ​Design: 
[Good for Getting started] 
https://engineering.ucsb.edu/~sumita/courses/Courses/ME141B/LEditGettingStarted.pdf 
[In depth Guide] 
https://www.southampton.ac.uk/~bim/notes/cad/reference/pdf/ledit.pdf 
 
      C) ​Exporting to GDSII:  

● Layers you want exposed must in the setup layers general tab have a GDSII number (1) 
and GDSII data type (0) to export to a GDSII file.  

● File>Export Mask Data>GDSII>ok 
● Figure 1.1 and 1.2 attached as reference. 

   Figure 1.1                                                                                            Figure 1.2  
 

 

https://engineering.ucsb.edu/~sumita/courses/Courses/ME141B/LEditGettingStarted.pdf
https://www.southampton.ac.uk/~bim/notes/cad/reference/pdf/ledit.pdf


      D) ​Exporting to CIF: 
● Layers you want exposed must in the setup layers general tab have a CIF name to 

export to a CIF file.  
● Cell>Fabricate>cell1>ok 
● Cell>Flatten 
● File>Export Mask Data>CIF>ok 
● Figure 1.3 and 1.4 attached as reference 

 

Figure 1.3                                                                Figure 1.4 
 
Tradeoffs between CIF and GDSII 
Normally, GDSII breaks up polygons larger than 199, however polygons can be generated with 
up to 8191 vertices. CIF has no such polygon limitation. As such, we used CIF files for most of 
our designs, since our focus will be on curved designs. 
 
Helpful Resource: ​A Complete Guide to the ​LayoutEditor​ Application 
[https://www.layouteditor.org/layout/file-formats/gdsii] 
 
 
 
 
 
 

 

https://www.layouteditor.com/


 
2.BACKGROUND 
 
2.1 CHALLENGES OF TRADITIONAL LITHOGRAPHY AND OUR SOLUTION 
 
 
Traditional photolithography is an expensive and time-consuming process that is unsuitable for 
prototyping due to the limitation of having a fixed pattern in a photomask. The Heidelberg MLA 
150 Maskless Aligner is a high speed direct write lithography tool, that we use to overcome the 
constraints described, for the purpose of waveguide fabrication. The system exposes patterns 
from a CAD layout directly to a resist coated substrate without the need for a physical 
photomask, using a 405nm laser modulated by a digital micromirror device. This allows for quick 
implementation of design changes, making it well suited for rapid prototyping and iterative 
modification at a relatively low cost. It is typically used to produce structures down to 1µm. 
 
2.2 BASICS OF ROUGHNESS 
 
Infrared (IR) on-chip waveguides require smooth micron resolution strips with sub micron (>100 
nm) roughness in order to meet loss requirements (>10db/cm). Roughness has two 
components, Line Edge Roughness (LER) which is defined as the roughness of a single 
printed pattern edge of the waveguide, and Line Width Roughness (LWR) which is the 
fluctuation in the physical distance between two printed pattern edges of the waveguide. 
Line Edge Roughness in waveguides comes from the etching process in which striations on the 
photoresist (PR) sidewall due to intrinsic resist roughness as well as non-uniform polymer layer 
cause pattern transfer down to the layer being etched. Smooth PR sidewalls can still cause 
rough etchs, whereas Rough PR sidewalls will always produce rough etches. 
 
2.3 SYSTEM OVERVIEW - HEIDELBERG MLA150 MASKLESS ALIGNER 
 
The MLA150 system consists of the following individual components and their main 
subcomponents: 
▪ Lithography Unit 

- Flow Box 
- Optics System 
- Granite Construction 

▪ Electronics Rack 
- User PC with Conversion 
- Power Supply and Emergency Stop Module 
- Stage Controller 
- STC-Rack 
- Integrated Network Hub 
- Stage and Laser Chiller 

▪ Cooling water supply 

 



▪ Operator workstation 
 
The housing of the lithography system is called the Flow Box. It provides a stable environment 
for constant exposure conditions by maintaining temperature laminar flow of clean air. 
The system is controlled by the user using a graphical user interface on the User PC. 
The optics system is comprised of a laser unit with optical elements for beam guidance, Digital 
Micromirror Device(DMD), Interferometer and Camera Unit. Several laser diodes emit a laser 
beam that is coupled in an optical fiber and projected on the DMD which modulates the beam 
and transfers a pattern corresponding to the pixels in an image onto resist coated substrate. 
A Digital Micromirror Device for spatial light modulation of laser light is used to project and 
transfer a pattern onto a resist coated substrate.The Camera Unit has one low resolution, one 
high resolution and one overview camera that are used for accurate alignment of a design with 
existing structures on a substrate. The laser interferometer is used for measuring stage position. 
The data entered by the user is processed by the components located in the Electronics Rack. 
The Stage Controller drives the stage through linear motors in both axes, the movement is 
controlled based on feedback from interferometers in the main unit which triggers the laser and 
DMD. 
 
3. FABRICATING WAVEGUIDES USING HEIDELBERG 
 
3.1 REASONING BEHIND MASK LAYOUT 
 
                                                                                    Ridge Matrix

 
 
                                                                                       Trench Matrix 
 
Figure 3.1: Mask Layout 
 

 



Our mask layout has the following elements 
A) Circles  

Width = 1.6 µm 
Radii = [5,7.5,10,12.5,15,17.5,20,22.5,25,50,100] µm 

 
      B) Straight Lines 
           Length = 1 mm 
           Width = 0.9 to 1.8 µm with 0.1 µm increment 
  
      C) Lines with ± 0.1° angle deviation [ vertical, horizontal and 45°] 
           Width = 1.6 µm 
            Length = 1 mm 
 
      D) Ridge Matrix  
           Arrays of 5 µm × 5 µm squares with decreasing spacing ( 3 to 0.1 µm) shifted by 0.1 µm 
in each row. 
        E) Trench Matrix  
             Inverse of Ridge Matrix such that the spacing between the boxes is the part that gets 
exposed. 
 
A known issue with the Heidelberg MLA 150 is that angled lines and circles show ‘kinks’ over 
long path lengths. This is due mainly to two factors, the discrete nature of the addressable 
mirrors on the DMD and the stitching of images between chuck movements. 
Part of our project was to characterize how designed angled lines and circles are stitched 
through computer software, which is described in Section 4.2. 
Angled lines come into play if the tool is used to fabricate optical structures like y-junction 
splitters for waveguides. Similarly the circular elements are used to characterize ring resonators 
and straight lines for rectangular waveguides. 
 
The Ridge and Trench Matrices are used for finding the optimal Dose/Defocus that gives the 
minimum feature size and creating a visual guide that shows  feature size space by conducting 
a Dose/Defocus Analysis as described in Section 4.1. 
  
3.2 PROCESS FLOW 
4” L Prime Wafer 

1. Standard Piranha Clean 
2. Singe and Prime wafer 

Using YES Oven. This process dehydrates the wafer at 150°C and primes the wafers 
using HMDS (Hexamethyldisilazane) which increases adhesion between oxide and 
resist. 

3. Spin coat resist on wafer 
This is done using SVG Resist Coat Tracks 1&2. We use Shipley 3612 Photoresist with 
a thickness of 1 µm and 2 mm Edge Bead Removal. 

 



    
 

4. Perform exposure  using Heidelberg 

 
- Create a dose/ defocus matrix of the pattern on the wafer 
- The dose varies from 91 to 60 91 mJ/cm^2, and defocus from -5 to 4 which gives us a 

32×10 matrix. 
 

5. Develop the pattern 

 
This is done using the SVG Develop Tracks 1&2. 
 

6. Image all Ridge and Trench Matrices using optical microscope  

- For collecting information on minimum trench/ridge width. 
 

      6.   ​Image individual patterns using Scanning Electron Microscope(SEM) 
- For collecting information on Line Edge Roughness 

 



 
 
 
4. IMAGE ANALYSIS SOFTWARE  
 
4.1 DOSE/DEFOCUS MATRIX ANALYSIS 
 
An important limitation of the Heidelberg as compared to the ASML or e-beam lithography tools 
is the resolution. According to the SNF website, a resolution of 1 micron is quoted. For this 
project, we set out to characterize and optimize the minimum features we could resolve based 
on dose and defocus for 3612 1um Shipley photoresist on standard 4’ silicon wafers (L-prime). 
 

 
Figure 4.1  
 
We choose to use two metrics for resolution: ​minimum ridge width​ and ​minimum trench width​. 
Our suspicion was that high doses improve the resolution of trenches. Low doses improve the 
resolution of ridges. Too high of a dose would destroy thin ridges, while too low of a dose would 
underexpose trenches as shown in Figure 4.1. Improving the defocus (which roughly 
corresponds to focal depth [1]) would improve both the ridge and trench resolution.  

 



 
In order to test this, we used the above design to create a dose defocus matrix from 60 
mJ/cm^2 to 91 mJ/cm^2, and our defocus went from -5 to 4.  
Using the optical microscope in the SNSF, we took pictures at x20 mag over the entire dose 
defocus matrix. One image for the pits/ridges (top) and one image for the boxes/trenches 
(bottom). These images were then fed into a software program that extracted the number of 
resolvable boxes or inverted boxes, which we refer to as pits (seen below). Due to over or under 
exposure, there would be a difference between the number of designed boxes or pits and the 
exposed boxes or pits along a single layer. Since boxes or pits were separated by increasing 
increments of 100 nm, an effective resolvable width can be calculated based on this difference 
in box/pit number. 

Figure 4.2 Image Processing steps for Dose/Defocus Matrix Analysis 
 
The minimum effective trench width and ridge width show three trends. First, lower defocus 
improves resolution for both trenches and ridges for our silicon photoresist stack. Secondly, 
smaller dose improves the resolution of ridges, while reducing the resolution of trenches. 
Thirdly, larger dose improves the resolution of trenches, while reducing the resolution of ridges. 
 
It seems then for dose there exists a tradeoff between minimum resolvable trench and ridge 
dimensions. We took the above data tables, and applied a squared sum score with an alpha 
weighted towards ridges to choose the best dose/defocus pair. Larger alpha values correspond 
to better ridge resolution while smaller alpha corresponds to better trench resolution. 

Since for most users over-exposure is preferable to under-exposure, and trench resolution is 
more important, we chose an alpha of 0.2. 
 
Result: Best Dose Defocus: (80,-6) 
 

 



 
Data obtained from Software to extract Minimum effective Trench and Ridge width across 
Dose/Defocus Matrix 

Figure 4.3                                                                     Figure 4.4 
 
 
 
 
 

 

 



Figure 4.5 
 
4.2 LINE EDGE ROUGHNESS EXTRACTION 
 
Overview 
A known issue with the Heidelberg comes from transfering long straight lines that are angled. To 
characterize this problem, we exposed long angled ridges and then took high resolution SEM 
images of individual sections. Using stitching software, we reconstructed long sections and did 
image analysis to extract the line profile. From this line profile we did LER and LWR analysis. 
 
LWR and LER roughness of 0.5 ​​°​ tilt 1.6um lines  
 
 

 

 
 

 
 

 
Figure 4.6 Multiple NOVA SEM images of a 1mm long, 0.5°, 1.6um PR strip on Si are taken.  

 



 
We remove the legend with Python software, stitch together the resulting images with ImageJ 
software. Below (Figure 4.7) is the fusion method and parameters used, as well as the resulting 
image in Figure 4.8, without and with legend. 

Figure 4.7 

Figure 4.8 (a) Stitched image without legend (b) Stitched image with legend 
 
 
 

 



Image processing to get line edge roughness and line width roughnes​​s 
 
We take the images stitched together and extract the curves in Python script using OpenCV. 
This is done in the following order: 
Gaussian Blurring ⇒ Thresholding ⇒ Morphological opening (Denoising) and Closing (remove 
holes) ⇒ Erosion ⇒ Morphological Opening ⇒ Multiple steps of Blurring and Thresholding. 
Finally a Canny Edge Detection Algorithm is used to find the two edges of the PR ridge. 
 

 

 



 
Finally, we extract the edge profile. Units of length are taken from the scale bar, and used to 
map the curves to relative positions. Above a line representing the original midpoint is 
generated. 
Designed angle:  0.57 degrees 
Measured angle: 0.40 degrees 
Furthermore, we used a simple RMS calculation to described the LWR and LER. 

 
 
Calculate RMS LER and LWR from  
LWR: 0.0353 um 
LER: 0.0285 um 
SEM Pixel resolution: 0.0067 um 
The FFT analysis (not shown) doesn’t capture that most LWR comes from large frequency 
swings. This is due to large noise at low spatial frequency. Code is provided below: 
https://github.com/broaddus/HDW 
 

 

https://github.com/broaddus/HDW


5. PROJECT IDEAS FOR WINTER 2019 
 
Below is a list of objectives that we aim to achieve by the end of the next quarter: 
1. Create similar Dose/Defocus matrix for photoresist strips on silicon nitride. 
2. Parameter sweep of etch conditions for creating silicon nitride on silicon oxide waveguides to 
find conditions to minimize LER and LWR. 
3. Study photoresist reflow on silicon nitride substrate as a method to minimize LER and LWR. 
4. Explore other methods of achieving minimum LER and LWR such as using plasma assisted 
resist reflow etc. 
5. Apply the software we created to find roughness parameters of nitride on oxide waveguides 
fabricated using Heidelberg MLA150. 
6. Develop a correlation table for roughness and power loss in these waveguides using 
measurement setup. 
7. Alignment marks to use with e-beam lithography JEOL 
 
 
Other ideas: 
1. Compare results for waveguide loss with those obtained from simulation 
2. Compare waveguide loss to same structures created using ASML Photolithography tool. 
3. Applying proximity effect correction with grayscale techniques  as described in  
[Jens Bolten,Thorsten Wahlbrink, Namil Koo, Heinrich Kurz, Stefan Stammberger, Uli Hofmann, 
Nezih Ünal, “Improved CD control and line edge roughness in E-beam lithography through 
combining proximity effect correction with gray scale techniques” ]. This paper used the 
commercially available software, Layout BEAMER to achieve this. We could try to implement 
this using open source software packages. 
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